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Chapter 1

Icons_menu

1.1 ABGTWB3 VOL 1

CLICK ON THE HELP BUTTON ABOVE OR PRESS THE HELP KEY ON YOUR KEYBOARD

IF YOU NEED TO KNOW HOW TO USE THIS GUIDE.

INTRODUCTION

WORKBENCH MENU WINDOWS MENU ICONS MENU TOOLS MENU

Backdrop New Drawer Open Reset WB

Execute Command... Open Parent Copy

Redraw All Close Rename...

Update All Update Information...

Last Message Select Contents Snapshot

About Clean Up Unsnapshot

Quit... Snapshot Leave Out

Show Put Away

View By Delete...

Format Disk...

Empty Trash

Related topics

1.2 vby

VIEW BY

-------

View By, lets you control the appearance of files in your windows in

four different ways:

Icons, This is the default setting where only files with an associated

icon are displayed, all other files are hidden from view.

Click on this diagram of View By/Icon.
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By Name, Displays ALL files from the current directory in alphabetical

order in text form, no icons are displayed at all.

Click on this diagram of View By/Name.

By Date, Displays ALL files in chronological order, files have date stamps

in them, only any use if you have a built in clock really.

Displayed in text form.

Click on this diagram of View By/date.

By Size, Displays ALL files, sorts the file list by size starting with the

smallest file listed first,of limited use. Displayed in text form.

Click on this diagram of View By/Size.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Make sure an open window is selected .

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight VIEW BY.

* Choose between the four options in the sub-menu, and then release right

mouse button.

1.3 show

SHOW

----

In normal, everyday use, using the default Workbench setting of

showing @{ " icons " link icon} only is fine, it saves a lot of useless files

being displayed and cluttering up the screen. Any file that does not have

an .info file associated with it will not be displayed in this mode.

As an example I have copied three files to the Ram Disk , they are:

Clock

Clock.info

invaders

When I Double click on the Ram Disk icon the Clock will be

displayed on the screen because it has an icon associated

with it, (the .info file) Where as Invaders will not be visible as it has

no .info file (icon). So, what happens if you wanted to run the Invaders

program? (Assuming you already knew it was there of course) There are a few

courses of action you could take. You could start the Invaders program from

the Shell . You could start it using the Execute Command

option from the Workbench menu. Or, probably the easiest, you could select
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SHOW and in the sub-menu select ALL FILES, this will display ALL the

FILES in the current directory wether they have icons or not, you can then

double click on ANY file and try to run it.

Look at this diagram of Show/All Files and this diagram

of Show/Icons Only.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Make sure an open window is selected .

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight SHOW

* Choose between ONLY ICONS or ALL FILES, and release right mouse button.

1.4 sshot

SNAPSHOT

--------

After using Clean Up you may want to make the new positions of

the icons , and may be even the window , permanent, if so,

then selecting SNAPSHOT will do the trick.

Take a look at this diagram and you will understand.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight SNAPSHOT

* Choose between snapshotting just the window position or ALL, the windows

position and the icons positions, and then release the right mouse

button.

* The new positions will be saved to disk.

1.5 cleanup

CLEAN UP

--------

This is an extremely handy option, use it regularly. Personally I would

of called it TIDY UP, but there you go! What it does is rearrange the

icons of the currently selected window , simple as that,

but effective.
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Take a look at this diagram and you will understand.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Double click on a disk icon to open it.

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight CLEAN UP and then release the right mouse button.

* Any icons in the window will now be tidied up.

FURTHER INFORMATION

-------------------

If you want the icons to stay in the new tidied position see snapshot .

Keyboard short-cut is: Hold down the right Amiga key

and press .

1.6 sconts

SELECT CONTENTS

---------------

To select or highlight an icon you need to click on it once

with the left mouse button.

But say you wanted to select a lot of icons all at once for an operation?

For example, let’s say you had sixty files on a floppy disk and that you

wanted to delete fifty of them. You could approach this in one of

four ways:

1) You could format the entire disk, no good because you would lose

the ten files you wanted to keep.

2) You could select each icon one at a time then select delete from the

icons menu, very time consuming indeed.

3) You could hold shift down and click on all fifty icons making them all

selected and then select delete, still a big job.

4) Or you do the right thing and use SELECT CONTENTS, this would select

all sixty icons, you could then de-select the ten files you wanted to

keep by clicking on them once with the left mouse button and then do a

delete from the icons menu to get rid of the fifty that would remain

selected.

As you may have gathered, SELECT CONTENTS highlights the whole contents of

the currently selected window .

Click here to see diagram for diagram.

FURTHER INFORMATION

-------------------

If you want to drag all of the selected files somewhere you will need

to hold the shift key down first.

Keyboard short-cut is: Hold down the right Amiga key and press A
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1.7 update

UPDATE

------

This is the baby brother of Update All found in the Workbench menu.

Where UPDATE differs from Update All is that it only updates the selected

Window and so is faster.

If you make changes to the contents of a window through the Shell

or the Execute Command menu item, you may not be able to see

any changes you have made unless you close and re-open that window.

Selecting UPDATE will UPDATE the contents of the Window without you having

to close & re-open it. It’s a matter of personal preference, personally I

find it faster to open and close the window myself.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Double click on a disk icon to open it.

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight UPDATE and then release the right mouse button.

* The window will now be updated and any changes made to it will appear.

View diagram for diagram.

1.8 close

CLOSE

-----

Virtually the same as Open Parent except this closes the

currently selected window .

It’s a lot easier and quicker to just use each window’s CLOSE gadget,

located at the top left of any window, click on it once with the left mouse

button.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Double click on a disk icon to open it.

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight CLOSE and then release the right mouse button.

* The window will now close.

Click on me for diagram.

Keyboard short-cut is: Hold down the right Amiga key and press K
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1.9 oparent

OPEN PARENT

-----------

OPEN PARENT isn’t an option you should worry about too much. Basically it

allows you to step back through nested directories and drawers if

you get in a tangle. For example, you may have opened a drawer and inside

that there is another drawer and inside that another drawer and inside

that...etc. Using OPEN PARENT you can step back a directory at a time.

Realistically it’s a lot easier and quicker to just use each windows

close gadget, located at the top left of any window.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Presuming you have at least one drawer open :

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight OPEN PARENT and then release the right mouse button.

* The drawer window should close .

Click on me for diagram.

1.10 newdrawer

NEW DRAWER

----------

This is a very useful option, it allows you to easily create a new

drawer on any disk, complete with an icon and your choice of name.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Double click on the disk icon of the disk you wish to create

the new drawer on.

* If necessary, double click inside a previously made drawer,

if you want to create a sub drawer.

* Hold down the right mouse button,

* Move the mouse pointer to the Window menu at the top of the screen.

* Highlight NEW DRAWER and then release the right mouse button.

* In the requester that will now appear, type in a new name or leave the

default name in, which is called Unnamed1.

* Click on Ok or press return.

* The new drawer is now created, complete with icon.
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Click on me for diagram.

FURTHER INFORMATION

-------------------

You can create as many drawers as you want, space permitting.

You can create drawers inside drawers, nested as much as you want.

You can use Rename to rename any drawer.

If you delete a drawer you will automatically delete all of it’s

contents, including sub-drawers and their contents.

If you drag a drawer to another part of the disk, or even

to another disk completely, all the drawers contents, including sub-drawers

and their contents will also be copied.

If you create more than one new drawer on a disk and are using the default

name of Unnamed1 then the Amiga automatically makes the next drawer name

Unnamed2, Unnamed3 etc.

Keyboard short-cut is: Hold down the right Amiga key and press N

1.11 quit

QUIT

----

Will exit Workbench and leave you stranded. You will not be able to

QUIT from Workbench while any Workbench programs are running.

A very forgettable option and virtually useless to beginner and expert

alike.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight Quit and then release the right mouse button.

* Click on me for diagram.

Keyboard short-cut is: Hold down the right Amiga key and press Q

1.12 about

ABOUT

-----

Selecting About displays a requester showing you the version number of

Workbench and Kickstart installed in/on your system.

This does the same as typing VERSION into the shell .
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QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight ABOUT and then release the right mouse button.

* Click on me for diagram.

Keyboard short-cut is: Hold down the right Amiga key and press ?

1.13 lmess

LAST MESSAGE

------------

This one literally re-displays the last message that was printed in the

menu bar at the top of your screen. If you select it, it will become

apparent. This is another virtually useless menu option, so don’t go

worrying about this one Ok.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight LAST MESSAGE and then release the right mouse button.

* Click on me for diagram.

1.14 rdall

REDRAW ALL

----------

Not much to explain here except that REDRAW ALL updates all open windows

on the Workbench display and redraws them, useful if some program upsets

the display, otherwise another menu item not worth worrying about.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight REDRAW ALL and then release the right mouse button.

* Click on me for a diagram.
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1.15 udall

UPDATE ALL

----------

UPDATE ALL is similar to Update .

UPDATE ALL re-opens ALL currently opened windows on the Workbench

screen, updating their appearance. So, if for example, you had been using

a program such as the Shell , that changed the contents

of a window Update All would reflect the new contents as Workbench

only updates the window display when needed and quite often will not

reflect the true contents of some windows. Admittadly this is not an often

used function as the same can be achieved by closing and re-opening a

window by hand by clicking on the top left gadget of any window.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight UPDATE ALL and then release the right mouse button.

* Click on me for a diagram.

1.16 open

OPEN

----

Using OPEN from the Icons menu is exactly the same as

double clicking on an icon with your mouse, nobody uses this menu item

as it’s just so much easier to double click instead.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Highlight an icon by clicking on it once.

* Hold down the right mouse button,

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight "Open" and then release the right mouse button.

* Click on me to see picture

Keyboard short-cut is: Hold down the right Amiga key and press O
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1.17 Trash

EMPTY TRASH

-----------

The Trashcan is just another way of Deleting files.

The bonus of using the Trashcan is that files are not

deleted immediately, they are stored ready for deletion by you later.

If you "Empty Trash" then any files you have previously dragged to the

Trash Can for deletion will now be deleted proper, you will NOT be able

to retrieve any files after this operation.

Please view this Diagram

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Make sure the disk in use is not write protected .

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight EMPTY TRASH and then release the right mouse button.

* All files in the Trashcan will now be deleted.

FURTHER INFORMATION

-------------------

You can make a Trashcan on your disk by choosing the "Trashcan" option

when you @{ " Format " link Format} a disk.

Icons can only be moved to a Trashcan of the same volume.

You cannot delete whole disks from the Trashcan

The Trashcan itself cannot be moved into a drawer.

The Trashcan itself cannot be deleted.

1.18 delete

DELETE

------

Delete performs the exact operation you would expect, it deletes files.

All you need to do is highlight an icon and then select "Delete" from

the Icons menu .

Take a look at this diagram

*WARNING* Once you have deleted a file you will not be able to retrieve it

without the help of a Public Domain program, I recommend

Arestaure as the easiest and best to use.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------
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* Make sure the disk in use is not write protected .

* Locate the desired icon to be deleted.

* Click once on the icon with the left mouse button.

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight DELETE and then release the right mouse button.

* Click on Ok to the requester to continue the deletion

* Or click on cancel to abort the operation.

FURTHER INFORMATION

-------------------

You cannot DELETE a disk icon as such, use Format

1.19 Away

Put Away

--------

This put’s away a previous icon left out on the Workbench

by using the Leave Out item.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Locate the desired icon to be Put Away.

* Click once on the icon with the left mouse button.

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight PUT AWAY and then release the right mouse button.

Obviously there has to exist an icon that you have already used Leave Out

on to make any use of this function.

Keyboard short-cut is: Hold down the right Amiga key and press P

1.20 Out

Leave Out

---------

This is a handy little option that allows you to leave an icon out

on the Workbench screen.

This is useful if you have a program that you use a lot, it saves you from

having to search out the icon as it’s already there sitting on the

Workbench screen just waiting to be double clicked on.

Example:

Let’s presume you use the shell a lot. Locate the shell icon and drag

it out of it’s drawer and onto the Workbench screen. Now select
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"Leave Out". Reboot your machine and load Workbench and you will find the

shell icon sitting there amongst the disk icons ready for use.

VIEW DIAGRAM 1 VIEW DIAGRAM 2

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Locate the desired icon to be left out.

* Click once on the icon with the left mouse button.

* Holding down the left mouse button,drag the icon to the Workbench screen.

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight LEAVE OUT and then release the right mouse button.

FURTHER INFORMATION

-------------------

The actual file is left in it’s original location, only the icon file

is actually moved.

Leave Out Cannot be used with floppy disks or the Trashcan.

You can actually use Leave Out on a floppy disk if the floppy boots up a

Workbench of course.

Admittadly this is of more use to hard drive users than floppy users.

Keyboard short-cut is: Hold down the right Amiga key and press L

1.21 unsnapshot

UNSNAPSHOT

----------

This undoes a previously Snapped icon . See Snapshot for more info.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Icons menu at the top of the screen.

* Highlight UNSNAPSHOT and then release the right mouse button.

Keyboard short-cut is: Hold down the right Amiga key and press U

1.22 snapshot

SNAPSHOT

--------

SNAPSHOT allows you to save the position of the selected icon(s) .

once snapped they will always reappear in exactly the same position.

Why? So you can customize your disks and Workbench and make it look tidy.
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QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Make sure the disk in use is not write protected .

* Highlight the icon by clicking on it once with the left mouse button.

* Hold down the right mouse button,

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight SNAPSHOT and then release the right mouse button.

* View Snapshot diagram

FURTHER INFORMATION

-------------------

You can select more than one icon at a time for snapping by clicking a

icon and then subsequently holding down the shift key while clicking on

any further icons.

Keyboard short-cut is: Hold down the right Amiga key and press S

1.23 information

INFORMATION

-----------

Highlighting any icon and selecting "Information" from the

Icons menu will display status information relevant to the disk or

file in question. View diagram

Some of the data can be changed and then saved within the icon.

View File Information diagram View Disk Information diagram

What data is present in each icon is usually specific but the following are

the most common ones present in most icons:

Name: :The icons name,

Type :Wether it is a Volume, Drawer, Tool, Project or Trashcan.

Image :A picture of the icon.

Size :The actual size in blocks and bytes of the file or

volume represented by the icon. doesn’t apply to

drawers .

Stack :Amount of memory set aside for a specific tool.

Doesn’t apply to drawers or disk icons.

Last changed date:When a file or icon is created or modified the Amiga

stamps it with the time and date. If your Amiga is fitted

with a clock this will be accurate, if not it’s usually

stamped 26th Feb 1992 as default.

Script :If the program is executed from the shell it runs a
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script file.

Archived :A flag Used by back up programs, ignore.

Readable :The file is readable, i.e. useable.

Writable :Changes can be made and saved to the file.

Executable :Runs automatically when opened (Double clicked)

Deletable :Can be deleted. By de-selecting this

you can protect valuable files from being deleted

by accident.

Save :Allows you to save the icon information, useful if you

have made any alterations.

Cancel : Click on it when you’ve had enough.

If there is a "Comments" box you can add a note of any relevance,

few people bother to do this though.

Default tool: This is mainly of use for project icons such as text files.

You can set the default tool for a text file to be your favourite text

viewer for example and when you double click on the icon it will load your

text viewer and then load the text file in automatically, clever stuff

what!

To make it a bit clearer here is an example:

letter.doc < This is a text file

More < An executable program that displays text files

kept in the C drawer.

DEFAULT TOOL:c/More

If you double clicked on Letter.doc More would run and display letter.doc.

If you ever come across the Unable to open your tool

error message it is because the path or tool is missing or wrong.

Select the icon and then "Information" in the Icons menu and change the

default tool to one you have on your system disk. Problem solved.

Tool Types:

-----------

Allows you define different start up options for certain programs or files.

consult the documentation for any particular program to find out what, if

any tool types are available.

If you do make any modifications to the tool types don’t forget to use the

"save" option to make the changes permanent.

I will be covering Tool types in depth in a later volume.
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1.24 copy

COPY

----

The Workbench COPY is pretty bad really and most people who get to know

Workbench use a nice friendly P.D copier, I recommend Super-Duper

copier available from ANY P.D library in the universe for a few quid.

But, we are here to learn how to use the COPY function.

Making a copy of a disk

-----------------------

To make a copy (or backup if you like) of a disk, here is what you do:

If you only have one disk drive

-------------------------------

First of all make sure the disk you want to make a copy of is

write protected , just in case things go wrong or you

accidentally get your source and destination disks mixed up.

Insert the disk that you want to make a copy of into your internal drive.

The internal drive is called DF0: the disk you want a copy of is called

the source disk.

Click on the source disks icon once to highlight it.

Select COPY from the Icons menu . View diagram

You will now get a message telling you the operation will take five disk

swaps, this is because you only have one drive, ALL Amiga owners most

definitely need a second drive, so go get one now! It’s like having a

washing machine, you can manage without one but once you have it you can’t

believe how you survived without it.

Click on Continue, you will now get another message prompting you to

insert the source disk, View diagram

you have already done that so click on continue.

The copying will now start and will be represented by a graphical

percentage bar meter.

After a short time You will be prompted to insert the destination disk.

The destination disk is the disk you want to copy onto, this should be a

blank or an unwanted disk as EVERYTHING on it will be overwritten.

Make sure your destination disk is NOT write protected, take out the source

disk and insert the destination disk and click on continue.

Repeat this procedure until the operation is complete.

You will now have a perfect copy of your source disk.

QUICK GUIDE IN PLAIN ENGLISH
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----------------------------

Copying a disk on a single drive

* Insert the source disk, write protected.

* Click once on it’s icon to highlight it.

* Hold down the right mouse button,

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight "Copy" and then release the right mouse button.

* Click on continue.

* Click on continue at the next requester as well

* When prompted remove the source disk and insert the destination disk,

which should NOT be write protected.

* Click on continue.

If you have a second drive

--------------------------

Things are a lot easier for owners of a second floppy drive, known as DF1:

First of all make sure the disk you want to make a copy of is write

protected, just in case things go wrong.

Insert the disk that you want to make a copy of into your internal drive.

The internal drive is called DF0: the disk you want a copy of is called the

source disk.

The destination disk is the disk you want to copy onto, this should be a

blank or an unwanted disk as EVERYTHING on it will be overwritten.

Put this disk into your external drive, DF1:

Now, click on the source disks icon once and keeping the left mouse

pressed down drag it on to the destination disks icon.

A requester will now appear asking you to insert your source and

destination disks, which you have already done, so click on continue.

View Diagram

The copying process will now start and no disk swapping is required, in

fact because of the Amiga’s great multitasking ability

you can go off and do something else like typing a letter into your word

processor while your disk is being copied.

When the copying has finished you will notice that the destination disk has

been automatically renamed to "Copy_of_" . If this is not desirable then

use the Rename option to rename the disk to that of your choice.

CAUTION: Remove the source disk first as the Amiga does not like holding

two disks with exactly the same name, it gets all confused you know!

QUICK GUIDE IN PLAIN ENGLISH

----------------------------
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Copying a disk using two drives

* Insert the source disk, write protected, into DF0:

* Insert the destination disk into DF1:

* Click once on the source disk icon and drag it over to the destination

disks icon and release the mouse button (Drag and drop)

* Click on continue.

Copying files to and from disks

-------------------------------

The Drag and Drop method described above can be employed to move

single files from disk to disk or even to different parts of the same disk.

As an example let us say we have a disk with a drawer called pics which is

currently empty and a picture file called picture.Iff. To copy Picture.Iff

into the drawer "pics" all we need to do is drag picture.Iff and drop it

onto the "pics" drawer icon. The result will be that Picture.Iff has been

copied into the "Pics" drawer and the original Picture.Iff will be

deleted.

1.25 format

FORMATTING A DISK

-----------------

To be able to copy your files such as text, programs and pictures to a

disk it first needs to be formatted. When you buy a new disk it is

unformatted so before it can be used on the Amiga you need to format it.

This section will tell you everything you need to know about formatting

floppy disks.

First of all how do you know if a disk has already been formatted or not?

Insert the disk and if the disk icon comes up as DF0:???? then you

need to format the disk.

If the Icon came up as anything other than DF0:???? then there could be

data already on the disk.

Remember once you have formatted a disk all the contents of that disk are

erased forever, although there are "Salvaging" programs available.

Please take a look at this diagram

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Write enable the disk to be formatted (close the tab)

* Insert a disk to be formatted.

* Click once on the icon of the disk you wish to format.
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* Hold down the right mouse button,

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight "Format Disk" and then release the right mouse button.

* Click on FORMAT

* A confirmation requester will then appear, click on "Format" again.

* You will now see a count down bar while your disk is being formatted.

* When the format has finished the disk will be initialized, this makes

the disk bootable.

You now know all that is needed to format a disk, read on if you want to

learn more.

FURTHER INFORMATION

-------------------

If the disk you are about to format has been formatted before, you can

choose "Quick Format" from the "Format Disk" requester, this formats your

disk in a couple of seconds. There is a slight drawback with quick format,

it does not check your disk for errors so stick to the normal format if

you want to play safe. You cannot use "Quick Format" on a new unformatted

disk though.

You can change the name of the disk by clicking the mouse pointer inside

the window named "New Volume Name:" Use the backspace key

(located to the left of the DEL key and has a left pointing arrow on it)

to erase the text and type in a new name. You can call a disk virtually

anything you want.

Hint:

You can use the cursor keys (located below DEL and HELP keys) to scroll

along the text and change parts of it.

You can choose not to have a Trashcan icon put on your

disk by clicking the check box and making the tick disappear. A Traschcan

allows you to drag files to it for deleting.

Other options available are:

"Fast File System", Using this will speed up disk access but the disk will

only work on Amiga’s with Workbench 3 or more. So if you plan to distribute

your disk bare that in mind.

"International Mode" Corrects a few case-sensitivity problems, but means

your disk will only work on Amiga’s with Workbench 2 or above.

"Directory caching" Is another option to enhance the speed of disk access,

namely making directories open faster. Again your disk will require

Workbench 3 or above.

As a general rule, format your disk with the following options, especially
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if you want to distribute your disk:

PUT TRASHCAN NO/YES (Doesn’t matter either way, your choice)

FAST FILE SYSTEM NO

INTERNATIONAL MODE NO

DIRECTORY CACHING NO

If you cancel a format during operation the disk will be unusable until you

fully re-format it.

There is in-fact another way to format a disk. If you open the SYS drawer

on your Workbench disk you should see an icon called "Format" this does

exactly the same job using the same software as described above, the only

difference being that you do not need to select a disk icon you select the

disk to be formatted from a displayed list.

One final note, don’t worry too much about naming your disk you can do that

at any time by using the Rename option, which can also

be found in the Icons menu.

1.26 rename

RENAMING AN ICON

----------------

To RENAME an icon , first click on the icon to be changed to highlight

it. Selecting RENAME from the ICONS menu at the top of the

Workbench screen allows you to change the name of ANY visible icon on the

workbench screen. You can change the name of drawers , files or a disk.

This is especially useful if you have copied a disk using Copy , as you

can delete the words COPY_OF_ . See Copy

When choosing a name to use it is advisable not use spaces before, after

or in the new name as this can lead to confusion.

You change the name of the icon by using the backspace key to erase the

text. Type in your new name and then click on O.k. Click on CANCEL if you

change your mind at any time and the icon will remain unaltered.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Make sure the disk is not write protected .

* Highlight the icon by clicking on it once with the left mouse button.

* Hold down the right mouse button,

* Move the mouse pointer to the ICONS menu at the top of the screen.

* Highlight "Rename" and then release the right mouse button.

* Use backspace to delete the old name.
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* Type in your new name.

* Click on OK.

Take a look at this DIAGRAM and then this DIAGRAM

You now know all that is needed to use RENAME, read on if you want to

learn more.

FURTHER INFORMATION

-------------------

You can select multiple icons to rename by first selecting an icon and then

holding down the shift key, keeping the shift key pressed down you can

click away on many icons, they will now be all selected. Select rename from

the menu and each time you finish renaming an icon the next in line will

appear for you.

Keyboard short-cut is: Hold down the right Amiga key and press R

Instead of deleting the old name with backspace a short-cut to do this is

the key combination of Amiga+x that is, hold down the right hand Amiga key

and then press X.

Instead of clicking on Ok you can press return if so desired, this is true

of most parts of the Workbench environment.

1.27 resetwb

RESETWB

-------

This option is for simply resetting your Workbench to it’s default

settings, in other words, the same as if you had just booted up your

Workbench. This menu item is rarely used.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the TOOLS menu at the top of the screen.

* Highlight RESETWB and then release the right mouse button.

View diagram

The tools menu isn’t a complete waste of time though, there are programs

such as the brilliant P.D utility, Tools Deamon, that uses the Tools

menu to add your own custom menu. This is especially useful to hard drive

owners, who can set up a menu to have all their most often used/favourite

programs in a fast and easy to use way. This saves you searching through

stacks of drawers and files trying to find that elusive program.

There are plenty of other programs that use the Tools menu trick .

Contact your P.D supplier.
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1.28 bdrop

BACKDROP

--------

Selecting Backdrop from the Workbench menu basically means

wether or not you will have a window around your Workbench screen.

Click on this Button to see a pictorial diagram, then click the

right mouse button to return back here.

Backdrop Off gives you the window. The only importance this window can

have is that not having it (Backdrop On) means you have a bit more

room for icons etc. Totally useless really and probably there just to

fill the menus up a bit. Don’t worry about this one.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight BACKDROP and then release the right mouse button.

FURTHER INFORMATION

-------------------

If you want to set the backdrop to your choosing, permanently, then set up

the backdrop and use Snapshot from the Window menu.

Keyboard short-cut is: Hold down the right Amiga key and press B

1.29 xcom

EXECUTE COMMAND

---------------

How do you run a program that does not have an icon?

The general answer to this question is to use the Shell , however there

is another way, using the EXECUTE COMMAND... item from the Workbench

menu. Simply select Execute Command, type in the path and the programs

name and click on Ok. If all is well the program will run.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

* Hold down the right mouse button,

* Move the mouse pointer to the Workbench menu at the top of the screen.

* Highlight "Execute Command..." and then release the right mouse

button.

* In the requester that will then appear, type in the path and name of the
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program you wish to run.

* Click on Ok.

Or for a more graphical explanation click here and then here .

OK. So the Calculator program does have an icon, it is just an example and

also goes to show you can run almost any program from this option.

Keyboard short-cut is: Hold down the right Amiga key and press E

1.30 path

WHAT IS A PATH?

-------------

A path, as far as the Amiga and most other computers are concerned is

a route leading to the location of a desired file.

Straight to some examples:

Let’s say you have a blank disk and you have named the blank disk

MY_DISK. Then you copy a file called FRED.TXT onto it.

The path for FRED.TXT would be:

MY_DISK: FRED.TXT

It doesn’t matter what disk drive MY_DISK is in as you have called the disk

by name. You could also of called the path:

DF0: FRED.TXT

In this case you are telling the Amiga that the file FRED.TXT is on the

disk in the internal drive.

If you wanted to use the external drive (DF1:) you could use:

DF1: FRED.TXT

It’s probably best to use the actual name of the disk if you can though.

Remember that after the disks name you MUST put a colon (:) this tells

the Amiga that you mean a device, which means a peripheral like a drive

or printer etc.

Now supposing FRED.TXT was inside a drawer called LETTER on MY_DISK?

MY_DISK: LETTERS/FRED.TXT

would work perfectly. The / tells the Amiga to look in a drawer.

What about sub-directories then?

MY_DISK: TEXT_FILES/LETTERS/FRED.TXT

and so on.

Most decent programs on the Amiga let you select a programs path by giving

you a file requester, where all you have to do is locate the file and

click on it. Alternatively, running most programs will simply mean

double clicking on the programs icon , so don’t worry too much

about this sort of thing if you are still learning.
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1.31 shell

WHAT IS THE SHELL?

------------------

I would have to write a whole book to cover this subject properly and

indeed there are books out there that cover the shell. For this tutorial

though I will just give you a fleeting glimpse of how to use the shell.

As this guide is primarily meant for absolute beginners I wouldn’t want to

go too far anyway, it would probably confuse rather than help most

beginners.

So in a nut shell (pun, fully intended) the SHELL program can be found in

the System drawer of your Workbench disk. Double click

on the SHELL icon and a window will open and a cursor

will await your command.

Here is a more graphical explanation of the shell.

When you have finished with the shell you can get rid of it by clicking the

top left hand gadget of the shell window or by typing in EndCli followed by

return.

The point of the shell is very similar to that of the Execute Command

option from the Workbench menu, simply type the path and name of the

program you wish to run.

The SHELL comes in useful if you want some info on your machine/disks or

files, for example, type in DIR and a listing of the current disks

directory should be shown. Now try AVAIL to find out how much memory

you have available, and it goes on.

The commands we used above are actually tiny programs supplied on your

Workbench disk in the C drawer. We will be discussing these in detail in a

future volume.

Well, there is a lot more to the shell than that, you can for instance run

programs with "arguments" which means telling the program to run in certain

ways, but that is another story I may also tell at a later date.

1.32 highlight

HIGHLIGHTING AN ICON OR MENU ITEM

---------------------------------

To highlight an icon is simplicity itself, just click on the desired

icon once with the left mouse button. If you look at the icon it will now

be inversed. I have also used the term highlight when talking about

selecting a menu item , when the menu item has inversed (turned black)

this means it is highlighted. Please take a look at this Diagram

and all should be clear.
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1.33 shortcut

KEYBOARD SHORT-CUTS

-------------------

To the right of some items in menus are key short-cuts.

Most of these short-cuts usually start with the A Amiga key symbol,

this key is located on the direct right hand side of the space bar on your

keyboard. To use the short-cut you must press and hold down the Amiga key

and then press the corresponding key next to it, for example the short-cut

to use the Open item in the Icons menu is Amiga O, so you press and hold

the Amiga key and then press O.

Please click here for a diagram

1.34 window

ALL ABOUT WINDOWS

-----------------

Windows are areas that you can open/close/move and size. A window usually

holds icons .

Take a look at this picture now to get a better idea of what I am

talking about.

When you Open a disk icon or a drawer icon a window will open.

The window will then display any icons that are visible in the current

mode. A freshly opened window will always appear in front of any other

previously opened windows and be automatically selected. Lots of windows

can be open at the same time, although only one window can be operated on

at a time.

You can arrange windows using the gadgets in the windows border, take a

look at this picture .

I will now explain the markings on the window diagram you should have just

looked at.

Close gadget: Click here to completely close the window.

Zoom gadget : Click on this to toggle the size of the window to small or

large. Experiment.

Depth gadget: Changes the position of the window, if it is behind other

windows it will be brought to the front and will become the

currently selected window. To send a window to the rear hold

the Shift key down whilst clicking on the depth gadget.

Scroll bar : Click and hold the mouse pointer over this bar and drag
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it to see parts of the window not currently in view.

Scroll arrows: Have the same purpose as the scroll bar except you just

click on them periodically.

Sizing gadget: This allows you to adjust the size of a window. To use,

click on the sizing gadget and hold down the left mouse

button. Now move the mouse to a new position. Release the

mouse button when the window is at the desired size.

1.35 write

ABOUT WRITE PROTECTING A FLOPPY DISK

------------------------------------

A floppy disk can be in two states, write protected and write enabled.

If the disk is write protected it cannot be formatted, files cannot be

deleted from it or saved to it and best of all viri cannot infect it!

If the disk is write enabled it can be formatted and written to.

When you purchase a new disk it is usually write enabled, to write protect

it locate the write protect tab and close it

using your finger nail or a pointed implement such as a pen or small

screwdriver.

1.36 viri

SOME FACTS ABOUT VIRI

------------------

A virus is just a small program, written by a bored/nasty programmer

and meant to cause us users a lot of hassle and sometimes money.

There are hundreds of different "strains" of viri on the Amiga.

Basically there are only two types of virus prevalent on the Amiga,

Link and Boot. I will cover Link viri next volume, but here I will tell

you about Boot viri as they are the most common of the two.

Some viri can format your disk, some wipe the odd file, some just flash up

an insulting message, one even reverses your mouse controls!

So, how does a virus get into your system and onto your disks?

A little story:

Fred Bloggs gets a new Amiga and asks his friend Joe Brown if he has any

P.D disks he can make a copy of, unknowingly Joe gives Fred an

infected disk he had previously got off another friend. Anyway, Fred runs

the disk and the virus loads in from the infected disk and copies itself
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into Freds Amigas memory . The virus copies itself into a special

part of memory that only gets cleared when the Amiga is turn off by the

power pack and not turned back on for at least 20 seconds.

So a copy of the virus is sitting in memory, and the original virus is

still on the disk. Fred finishes playing the game and decides to load

another disk, he flicks off the power supply for a second or two inserts

the new (clean) disk and turns the power back on.

The virus has survived as the Amiga operating system didn’t have long

enough to clear all of it’s memory properly. Fred’s game is loading, the

virus is monitoring freds Amiga for any disk activity, the virus checks to

see if the disk is write protected or not, it isn’t,

Great! says the virus and copies itself onto the new disk. After copying

itself onto 20 different disks the virus activates itself proper and lets

fred know of it’s presence, the virus prints a nasty message on the screen

and wiped the disk in freds drive, the disk just happened to be an

expensive application fred bought last week. This will happen when each

copy of the virus has copied itself another 20 times. Can you see how

within a few days all of Freds disks were infected? If Fred had taken a

few simple precautions none of this would of happened.

* Always keep your floppy disks write protected at all times, only write

enable them when absolutely necessary.

* Use an up to date virus checker on any new disk you get before running

the disk proper. Look at this picture .

WARNING:

If you virus check a commercial game be careful as most commercial games

(and some P.D games and demos) use a custom loader on the bootblock which

most virus checkers will detect as Non-standard, unless the virus checker

says the disk has a virus and gives you the name of the virus don’t try

and kill it. As a general rule, if a virus checker says the disk has a

non standard boot block then 99.9% of the time it will be harmless or will

be a programmers boot loader, if it is a boot loader and you kill it the

disk will be rendered useless. This only applies if you use an up to date

virus checker.

* When resetting the Amiga to use another program make sure you turn off

from the power pack and wait at least 20-30 seconds. The down side of

this is the Amiga’s circuitry is at it’s most vunerable to electrical

surges when switch on from the mains.

Beginners should NOT use the Amiga/Amiga/ctrl keys to do a warm reset.

UNLESS you WRITE PROTECT all of your disks.
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If you think you have a virus on a disk and are not sure what to do, send

me the disk with a cover note and a SAE and I will check it out for you.

No SAE no reply.

*************************************************************************

Once again I cannot stress how important it is to keep your disks write

protected, if you do a virus will NEVER spread into your collection it will

stay on it’s original disk and sit in memory. W A I T I N G........

**************************************************************************

1.37 mouse

ALL ABOUT YOUR MOUSE

--------------------

The mouse is a great tool used by you to communicate with your Amiga.

The operation of a mouse is simplicity itself, though first time users of

a mouse tend to find the concept hard to get used to. After a few hours

of use though even a child can handle a mouse with ease.

For best results the mouse requires a flat surface to operate on. If you

don’t own a mouse mat then buy one for around £2 upwards.

The standard Amiga mouse has two buttons the right hand button, commonly

referred to as the menu button and the left hand button known as the

selection button. Throughout this tutorial I will refer to these buttons

as left mouse button and right mouse button to save any confusion.

Things you can do with your mouse:

----------------------------------

Pointing: move the mouse and watch the mouse pointer on the screen.

Clicking: Press and release the left mouse button once.

Double-Clicking: Two quick clicks on the left mouse button.

Holding Down: Holding down a mouse button.

Dragging: Hold down the left mouse button and drag an icon/window or

screen to a new position. Also known as drag and drop.

The mouse will give you many years good service if you clean it once in a

while. If your mouse seems to be dragging turn it upside down and unscrew

the holder. Inside is a ball, clean this with warm soapy water and dry it

thoroughly. Inside the mouse casing you will see some rollers that by now

have probably picked up a lot of dust and dirt. Get a small brush, like

the ones you sometimes get with electric shavers and clean the rollers.

Your mouse will be as good as new.

FURTHER INFORMATION
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-------------------

Just as a matter of interest or indeed if your mouse is broken, did you

know that you can actually control the mouse pointer with the keyboard?

Hold down the left Amiga key and move the pointer with the cursor keys.

Hold down shift as well to move the pointer in bigger steps. The left and

right alt keys act as the mouse buttons. Also the left mouse button can

be emulated with the firebutton on a joystick in port one.

1.38 icon

What is an Icon?

----------------

An Icon represents a file on your Workbench screen. It is, in effect, a

small picture. An Icon is a separate file in itself, but can be manipulated

using the Information option from the Icons menu .

If you @{ "Delete " link delete} an Icon, Workbench will automatically delete the file or

program it represents.

If you Open an Icon it will attempt to execute the file it represents.

You can manipulate the position of an Icon by dragging it to a desired

position, and then using Snapshot to save it’s position.

Different types of Icons

------------------------

A disk icon represents a Disk (otherwise known as a Volume) and only

appears on the actual Workbench window .

Click here to see a disk icon

A drawer icon represents a directory, which can hold programs/files or even

more drawers , known a sub-drawers or sub-directories.

Click here to see a drawer icon

A tool icon represents an executable program, like the clock utility

program. A tool can be run by double clicking on it.

Click here to see a tool icon

A project icon represents a file created by a tool, such as a text file or

a picture file.

Click here to see a project icon

The Trashcan icon simply represents the Trashscan .

There are also a set of built in icons called pseudo icons that the Amiga

uses to represent files that do not already have an icon associated with

them. To see these pseudo icons you need to use the Show/All files from

the Windows menu.

Click here to see Pseudo icons .
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1.39 menu

ALL ABOUT MENUS

---------------

Menus can usually be found a the top of the screen like on your

Workbench . To access the items in a menu hold down the

right mouse button and move the mouse over the title bar.

A list of headings will appear move the mouse pointer down a list of

items, notice how each item is highlighted as your

pointer moves over it. When you have highlighted your desired item release

the mouse button.

If an item in the menu is ghosted then this means that particular item is

not usable at the current time, for example, the Format item in the

Icons menu is ghosted until you have clicked on a disk

icon to be formatted.

To the right of some items are key short-cuts . Most of these

short-cuts usually start with the A (Amiga key symbol, this key is located

on the direct right hand side of the space bar on your keyboard.

To use the short-cut you must press and hold down the Amiga key and then

press the corresponding key next to it, for example the short-cut to use

the Open item in the Icons menu is Amiga O, so you press and hold the

Amiga key and then press O.

If a name of an item is followed by three dots (...) this means a requester

of some sort will follow if you select that item, For example, try the

Information item in the Icons menu.

If you see a >> symbol this means that item has sub-items attached to it.

Select the Snapshot item in the Windows menu for an example.

A tick or checkmark if you like, indicates that particular option is in

use. See Backdrop in the Workbench menu.

Don’t forget a programs window must be selected before you can access the

menu bar. If the window isn’t active just click anywhere inside it.

Please click here to see a diagram

1.40 the

USING THE TRASHCAN

------------------

You can use the Trashcan as a temporary store for files you want to delete.

Once stored in the Trashcan files are quite safe until you either turn off
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your Amiga (or reset it) or if you use Empty Trash

EMPTY TRASH then deletes the contents of the TRASHCAN forever.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

To store a file ready for deletion into the Trashcan.

* Click on the desired icon with the left mouse button.

* Keeping the mouse button pressed

* Drag the icon over to the Trashcan and then release the mouse button.

Where using the Trashcan comes in useful is if you decide not to delete one

or more of the files already in the can.

QUICK GUIDE IN PLAIN ENGLISH

----------------------------

To retrieve a file from the Trashcan.

* Double click on the Trashcan icon.

* Click on the desired icon with the left mouse button.

* Keeping the mouse button pressed

* Drag the icon over to your desired location and then release the mouse

button. The file is now safe.

Please look at this diagram

FURTHER INFORMATION

-------------------

You can select mutilple files by first selecting a file and then holding

down the SHIFT key and then selecting more files. Now drag them out.

1.41 drawers

ALL ABOUT DRAWERS

-----------------

Imagine a floppy disk with 100 pictures on it. Imagine that the pictures

covered ten different subjects. Wouldn’t It would be nice to be able to

group the pictures into ten different categories and lump them all in one

place for quicker reference? It certainly would!

This is where drawers come in real handy. You can create as many drawers as

you want on a disk and call them what you want. Going back to our disk of

pictures, we could create ten drawers and name each drawer to reflect it’s

contents , for example CAR_PICS, TRAIN_PICS, BOAT_PICS, PLANE_PICS, etc..

We could then drag the ten pictures for a certain category

into their corresponding drawer.

You could, in theory, use the Amiga without ever HAVING to create a drawer,

but drawers are there for our convenience and they are VERY useful.

Virtually every disk you will ever come across will have drawers on it so

you may as well get used to the idea and benefit from their use.

To open a drawer just double click on it.
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1.42 help

HOW TO OPERATE THIS PROGRAM

---------------------------

This tutorial uses Commodore’s AMIGAGUIDE document displayer. The reason

for using this software is that it allows interaction of words and

pictures, amongst other things.

*! USE THE UP & DOWN ARROW KEYS TO SCROLL UP AND DOWN THIS TEXT SCREEN !*

Along the top of the screen you will see a line of buttons as follows:

CONTENTS INDEX HELP RETRACE BROWSE < BROWSE >

If you click on the CONTENTS button with the left mouse button you will be

returned to the main menu screen, the place where this program started.

CONTENTS will be ghosted if you are already in the CONTENTS screen.

The INDEX button is not used in this tutorial.

HELP, well, you are reading this so you know what that does!

Clicking on RETRACE will literally RETRACE your steps through this guide.

For example, let’s say you clicked on the COPY button,

read that then clicked on the FORMAT button, retrace would take you back

to COPY and RETRACE again would take you back to the CONTENTS screen.

RETRACE is very useful because in most texts I have used buttons on key

words that you can click on to get a full explanation of that term. When

you have finished reading the definition of that term just use RETRACE

to go back to the exact place in the previous text that you came from.

Incidentally there is no RETRACE in this particular file as it’s a

separate database file from the main menu, that’s why it has opened a new

window . You can in fact click on the top left hand

gadget of this window (The one next to the word help) to exit back to the

main menu.

DO NOT click on the gadget in the top left hand corner

of the screen (The one next to ABGTWB3 VOL 1) as you will exit this

program, if you do then you will have to turn your Amiga off and re-load.

BROWSE < ,Clicking on this will let you BROWSE through the pages of text

in this whole document one by one. BROWSE < takes you backward.

If you want to PRINT out any part of this tutorial you can select PRINT

from the pull down Menu at the top of the screen.

To do this first make sure your printer is on line and ready. Hold down

the right mouse button and move the mouse pointer to the top left hand of

the screen. Move the mouse pointer to the word PRINT and then release the

mouse button. This disk is set up for a standard epson printer, so should
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work on most machines.

Don’t forget that most texts are longer than the visible screen, keep an

eye on the blue meter bar on the right hand side of the screen, click on

the up and down arrows to scroll through the text. Alternatively you can

drag the bar up and down with your mouse or even easier

use the arrow keys, it’s up to you.

If you click on a button that displays a picture, just click the right

mouse button to exit the picture and return back to the text.

Now click on the CONTENTS button at the top of the screen for the

main menu. Good luck..

1.43 intro

The Absolute Beginners Guide To Workbench 3.0

ˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆˆ

INTRODUCTION

ˆˆˆˆˆˆˆˆˆˆˆˆ

This is the first volume of what I hope will be a long running series of

tutorials on using Workbench 3. This disk concentrates on the Workbench

menu’s, though a lot more incidental information is also covered by way of

reference.

Why has it taken a whole disk just to cover the menus? You may ask!

Because I have looked at a lot of other Workbench tutorials and none of

them seemed to go into much depth and took a lot for granted, such as the

user knowing how to format a disk for example. In this series of tutorials

if an action such as format is mentioned it will be a "button" that you

can click on and this will take you to an in-depth explanation of the

term and why/how/when to use it. You will also usually find an

accompanying diagram and a "IN PLAIN ENGLISH" guide, giving at least two

and more usually three different ways to understand and digest the subject.

I would like to point out here that most of the screen shots containing a

picture of the menus in action are actually reconstructed by hand,

I am not very artistic but they are as close as I could make them.

I just could not find a screen grabber that could grab Workbenches menus.

Another point I should mention is that I have taken for granted that you

are using an Amiga WITHOUT a hard drive and have to load Workbench from

floppy disk. I have adopted this approach as being the most likely set up

for an Amiga beginner. If you do have a hard drive it doesn’t matter

anyway, just don’t get confused if I say something like Load your
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Workbench floppy!

By the way as there was a bit of space left on this disk I have put two

very good PD programs on here for you. The first is Filemaster, a great

file and disk utility and Quickgrabber. As this was a last minute

desicion I do not have the time to explain how to use them, but the full

documents are supplied with the programs. To get to them load Workbench

and double click on the PD_UTILS drawer. Be careful with Filemaster as you

can format and delete disks and files, read the docs first!

If you have any constructive criticisms/ideas for improvements, or want a

say in how future volumes will be written then please feel free to write

to me at the address below. I would also love to know if you have actually

learnt anything from this guide! If not tell me what I am doing wrong.

Please include a stamp if you want a reply. I will also try to solve any

problems you may have relating to the use of this program or a subject

within it. Please remember though, no stamp, no reply. My address is:

Steve Bye

F1 Licenceware

31, Wellington Road

Exeter, Devon. EX2-9DU

If you want a free F1 catalogue disk with your reply then please include

a blank disk.

I will also forward information on how the next volume(s) are progressing

if requested.

* Volume two will cover the preferences part of Workbench, if you have

had a look inside the prefs drawer on your Workbench disk and found

nothing you are not alone (Look on the Extras disk) I am looking forward

to tackling some pretty tricky subjects here so tune in soon. Volume two

should be ready by Mid March 1995, call 01392-493580 to find out.

Please note this number is NOT for technical help, this MUST be done by

post.

IMPORTANT NOTICE

THIS FIRST VOLUME OF ABGTWB3 IS IN THE PUBLIC DOMAIN, WHICH MEANS IT CAN

BE COPIED AND PASSED AROUND BY ANYONE, VOLUME 2 AND HIGHER ARE NOT P.D

AND MUST NOT BE COPIED/SOLD OR PASSED AROUND EXCEPT BY OFFICIAL F1

DISTRIBUTERS.

ALL FURTHER VOLUMES OF THIS SERIES WILL BE LICENCEWARE, NOT P.D, I HAVE

ONLY RELEASED THIS FIRST VOLUME TO GIVE YOU A TASTER OF WHAT IS TO COME.

ALL FUTURE VOLUMES WILL ONLY BE AVAILABLE FROM F1 LICENCEWARE OR ANY

OFFICIAL F1 DISTRIBUTER AT THE REASONABLE COST OF £3.99 PER VOLUME.
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ANYONE PURCHASING VOLUME 2 OR HIGHER DIRECT FROM F1 WILL RECEIVE NEWS OF

NEW VOLUMES AS THEY APPEAR, FREE OF CHARGE.

DISCLAIMER

----------

The author of distributer cannot in any way be held responsible for any

damage to person or appliance through use of this software.

All information contained here in is believed to be accurate and correct

at time of publication.

----------

1.44 tips

HINTS AND TIPS

--------------

Follow these few simple tips and you won’t go far wrong

* ALWAYS keep your floppy disks write protected this

very simple precaution can save you many hours/days/weeks of misery

with viri and corrupted disks.

* NEVER eject a disk from the drive until ALL disk activity has completley

stopped, not just the drive light, listen to the whirring as well.

* Never plug/unplug peripherals such as drives/printers/modems/cdroms

while your Amiga is switched on, the manual even tells you not to unplug

your mouse while the machine is on, that’s a bit over the top I think

but they must know! After all they created the machine!!

* ALWAYS check any new disks with a good recent Virus Checking program

before running the disks.

* If you have a hard drive have a virus checker running in background

so it constantly checks memory for viri and checks any disk inserted.

* Give your mouse a clean as soon as it starts to

drag a bit, this will stop frustration for you and prolong the life

of your squeaky friend.

* Until you know exactly what you are doing you should NOT use the

Amiga/Amiga/ctrl keys to do a warm reset. The main reason for this

is that if your machine has a virus in memory a warm reset will NOT

clear it out. Turn off your machine by the power pack and wait at

least 20 seconds.

* A second disk drive is ESSENTIAL unless you want to go insane.

You can pick up a second hand for about £35-£40, but they are rare

as once you have one you will not want to part with it.
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* A hard drive is desirable, especially if you are a power user, or want

to program or use other creativity tools or if you use Workbench a lot.

If you do buy a hard drive get the biggest capacity you can afford, and

I bet that won’t be big enough.

* A printer would be highly beneficial to most people for obvious reasons.

For a beginner a cheap old 9 pin dot matrix will suffice. From about

£50 second hand or about £100 new. Well worth it.

1.45 multitasking

WHAT IS MULTITASKING?

--------------------

I am only going to skip over this subject lightly here as it will be

fully covered in a future volume. Basically, multitasking is the ability

of a computer to run more than one program simultaneously. A very good

example can be seen by double clicking on the utilities drawer on

your workbench disk.

Inside the drawer are two programs, Multiview and Clock. double click on

the clock, and when that is running double click on the same clock

icon again, you now have two clocks running, though to see them you

will need to drag the top-most clock to one side to see the one

beneath. You are now multitasking.

You could keep on loading clocks, until you run out of memory .

A drawback of multitasking is that each program takes it’s slice of

processor time because in reality a computer can only perform one operation

at a time, the Amiga is simply switching from one clock to the next but it

is doing it so fast it all appears to be happening all at once.

So what use is multitasking? You may ask, well, what about copying a disk

whilst typing and then printing a letter with a bit of Amiga music playing

in the background? 99% of PC users are stunned when they see the power of

the Amiga multitasking, most PC’s shudder to a halt when multitasking.

Multitasking isn’t something many Amiga beginners can appreciate but as you

slowly discover the many and great benefits it holds you will soon warm

to it.



Icons_menu 36 / 39

1.46 memory

ABOUT MEMORY

------------

Memory is a term used to describe storage space inside a computer.

There are many different types of memory, but at this stage of the tutorial

I will just mention the two most important, RAM and ROM.

ROM stands for Read Only Memory, and this is fixed inside your computer.

It can’t be written to, it can only be read, as the name would suggest.

This part of your Amiga is only of direct interest to programmers and a

beginner needs to know nothing about ROM at this stage, suffice to say

that a part of the Amiga’s operating system resides there called Kickstart.

RAM stand for Random Access Memory, this is memory that we load programs

into. A standard Amiga A1200 has two megabytes of Chip Ram.

Chip Ram is memory accessible by the Amigas custom chips and the

processor. It is also used to store graphics and sounds. It can be used by

programs too but is slow.

You can increase the amount of memory in your Amiga by fitting a RAM

upgrade, this will be Fast RAM.

Fast Ram is memory that is only accessible by the main processor. This is

where most programs are stored and tend to run a lot quicker than from

Chip Ram, hence the name.

For the absolute beginner this is all academic, you do not need to

understand anything about memory at this stage.

1.47 disk

WHAT’S THE RAM DISK ABOUT?

--------------------------

The Ram disk is always available if you have loaded Workbench . You can

To see the Ram Disk icon Click here .

Using the Ram Disk is like having an extra disk drive, except it’s super

fast. The Ram disk, as it’s name would suggest uses your Amiga’s memory

as if it was a disk, and it’s size is only limited by the amount of free

memory you have available. It’s main use is as a temporary storage place

for files. If you look carefully you will find Workbench itself uses the

Ram Disk to store odds and ends for it’s own purposes.

FURTHER INFORMATION

-------------------
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When you turn off your computer the contents of the Ram Disk are lost

FOREVER, so be careful.

The Ram Disk is always 100% full because it expands and contracts it size

as required, so because it says 100% full, don’t think you can’t copy

anything into it.

You cannot copy a whole disk to the Ram Disk by dragging a disks

icon over the Ram Disks icon, open up the Ram disk icon

first and then drag the disk you want to copy into the Ram Disks window .

A drawer will be created automatically with the disks

name and it’s contents will be neatly inside the new drawer.

There are many uses for the Ram Disk which I plan to cover at a later date.

1.48 pd

What is Public Domain?

---------------------

Public Domain (P.D from now on) is an incredible concept, a programmer

spends weeks, months or even years writing a program and then GIVES it away

to all you fellow users! Sounds unbelievable I know, but it’s true.

As you know Volume 1 of this tutorial is in fact P.D, I released this into

P.D as a form of free advertising and to gauge by feedback if it is worth

my while to continue with this series.

Now you may be thinking there must be a catch, well, you don’t actually

get it for nothing if you go to a PD library, you have to pay a small

handling charge, normally between £1-£2 per disk, although there are

libraries who charge anything up to £4 a disk. If you have paid more

than £2.50 for a PD disk then look elsewhere.

I recommend 17 Bit Software as the best all round library in the UK,

they are not the cheapest at £1.50 a disk but the service is exceptional

and you get your order fast, with a friendly service, end of plug.

Getting back to the subject at hand. When a program is released as PD it

means you can basically do what you want with it, give it away, copy it,

sell it even! Though the unwritten PD rule is that you should not make a

profit from PD, only cover your costs. You would be forgiven in thinking

that PD programs must be crap! Well a lot of it is but then again some of

the best ever pieces of Amiga software are PD, check out some magazine

cover disks for some good PD, you will be surprised at the quality of some

it, there are some real gems out there. Here is a list of some of my

favourite PD programs that you could do worse than have in your collection:
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Tools Daemon: (A workbench menu system, best for hard drive users)

Filemaster : (A brilliant directory utilitie, copy,delete,format etc.)

Edword : (Best text editor, this tutorial was written with it!)

Super Duper : (Fastest/best disk copier, great)

Arestaure : (Recovers deleted files, has saved my life loads of times.)

Guiarc : Excellent de-archiver, easy to use.

Dos Trace : Tracks what your Amiga is doing internally, indispensable.

Disk Masher : A great and easy to use disk archiver.

Secenery Gen: Unbelievable, scenery generator, like the £60 Vista program

but FREE, and better!!!

There are tons more, but you get the general idea! Admittedly most of the

above programs will be of little use to a complete beginner so don’t worry

about what they are for now as I will be covering PD utilities in depth

in a future volume, by then you will understand why you will need them.

There are other forms of P.D such as:

Shareware

---------

this means if you find the program useful you should send the

author a set fee. This usually means you will receive a newer version of

the program or an uncrippled version.

Licenceware

-----------

Licenceware is NOT P.D, in fact it is commercial software, fully

copyrighted. The only difference to the normal £30 programs you see in

Smith’s is the packaging and the price. Most Licenceware sells from £3.99

upwards. It is illegal to sell/copy or give it away. The Amiga magazines

have not helped people to understand this by calling Licenceware, P.D.

1.49 workbench

WORKBENCH

-----------

Workbench is not your enemy, though at first it may seem to be, it’s there

to help rather than hinder. Just try using Windows on a PC computer to see

what life without a DECENT Graphical User Interface (G.U.I) is like.

Workbench is basically a set of programs, some stored in Rom,

and most stored on disks (floppy or hard). The great part of this set up

is that to upgrade the system just mean getting a new floppy rather than a

new chip. This also leads to a very flexible system that can be customized
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to the users preference. Totally new programs can also be bolted on at

will.

Workbench allows you to communicate with the inner workings of you Amiga

via mouse and keyboard, without Workbench, or a similar program, you

would need to be a programmer or use lots of separate programs to do simple

things like copy files and format disks.

Personally I use a mixture of good P.D utilities and the Workbench

together. Depending on your needs, you too will gradually find your own

suite of programs on and off the Workbench that suite you best.

The whole point of these tutorials is to explain the workings of the

Workbench, so it seems pointless to go rambling on here.

Just take my word for it, Workbench is probably the friendliest and most

efficient G.U.I ever designed for a computer.

1.50 topics

Topics relating to subjects discussed in this tutorial

About Workbench

All about windows

All about your mouse

What is an icon?

All about menus

All about drawers

Highlighting an icon or menu

What is a path?

What is the shell?

Using the Trashcan

What’s the Ram Disk about?

Keyboard short-cuts

About memory

What is multitasking?

Write protecting disks

Some facts about viri

What is P.D?

Hints and tips


	Icons_menu
	ABGTWB3 VOL 1
	vby
	show
	sshot
	cleanup
	sconts
	update
	close
	oparent
	newdrawer
	quit
	about
	lmess
	rdall
	udall
	open
	Trash
	delete
	Away
	Out
	unsnapshot
	snapshot
	information
	copy
	format
	rename
	resetwb
	bdrop
	xcom
	path
	shell
	highlight
	shortcut
	window
	write
	viri
	mouse
	icon
	menu
	the
	drawers
	help
	intro
	tips
	multitasking
	memory
	disk
	pd
	workbench
	topics


